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Version 1.0 
June 12, 2007 10 reasons to consider upgrading to Office 2007 

By Jody Gilbert 

Office 2007 offers new file formats, an improved user interface, and a number of deployment, support, and 
security improvements. Here are a few things to think about as you decide whether an upgrade makes sense for 
your organization. 

Office 2003 and its predecessors are out of date 

The Office platform was built on what are now antiquated technologies—and it has accumulated a lot of gunk over 
the years. For some perspective, consider that the first version of Word for Windows, released in 1989, had 
roughly 100 commands and two rudimentary toolbars. Word 2003 has more than 1,500 commands and 30-plus 
toolbars. As the bells and whistles piled up, a lot of flaws and problems were worked around, built on top of, and 
left unfixed. 

Office 2007 represents a clean break in platform design, built from the ground up to shed the superannuated 
binary file formats and enable a new (forgive me) paradigm for usability. Instead of trying to implement some fairly 
critical enhancements on top of the existing design (e.g., blogging capabilities and security features like the 
Document Inspector), Microsoft opted to incorporate those changes, along with a radically re-architected 
interface, into a brand new model. 

Office 2007 comes in eight flavors 

A certain amount of grumbling has accompanied what some perceive as needless packaging complexity and 
marketing gamesmanship, but in fact, it might serve your organization well to have eight editions to choose from. 
The versions (which are detailed in "Which edition of Office 2007 is right for you?"), run the gamut from a bare-
bones OEM installation to elaborate systems for heavy lifting in the enterprise: 

 Microsoft Office Basic 2007 
 Microsoft Office Home & Student 2007 
 Microsoft Office Standard 2007 
 Microsoft Office Small Business 2007 
 Microsoft Office Professional 2007 
 Microsoft Office Ultimate 2007 
 Microsoft Office Professional Plus 
 Microsoft Office Enterprise 2007 

You'll definitely want to closely analyze the included applications, supported technologies, upgrade paths, and 
pricing to make sure you're not paying for more than you need or sacrificing essential components. 

Pricing is about on par with Office 2003 3 

1 

2 

The price structure for Office 2007 maps pretty closely to Office 2003. For example: 

 The retail price for Office Professional 2007, which includes Word, Excel, PowerPoint, Outlook with 
Business Contact Manager, Office Accounting Express, Publisher, and Access, costs $499 dollars ($329 
for the upgrade). 

 The retail cost for Microsoft Office Small Business 2007, which includes Word, Excel, PowerPoint, 
Outlook with Business Contact Manager, Office Accounting Express, and Publisher, costs $449 ($279 for 
the upgrade). 

 The Microsoft Office Standard 2007 edition, which includes Word, Excel, PowerPoint, and Outlook, costs 
$399 dollars at retail for the full version ($239 for the upgrade). 
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If you need a lot of stuff, the upper-end versions can deliver 

If your organization is large enough or has diverse enough needs, it might make sense to purchase Microsoft 
Office Enterprise 2007 licenses. This will provide you with a huge variety of Office 2007 applications and 
technologies—Word, Excel, PowerPoint, Access, Outlook, and Publisher, as well as InfoPath, Groove, OneNote, 
and Communicator, plus support for Enterprise Content Management, integrated electronic forms, and advanced 
information rights management and policy capabilities. 

The Office Professional Plus edition offers a more modest lineup: Word, Excel, PowerPoint, Access, Outlook 
(without Business Contact Manager), Publisher, InfoPath, and Communicator. It also supports integrated ECM, 
electronic forms, and advanced information rights management and policy capabilities. Both packages are 
available through volume licensing. 

New file formats offer numerous advantages 

Office 2007 introduces the XML-based Open XML file formats for Word, Excel, and PowerPoint. These formats 
offer a number of significant advantages: 

 More compact size (the files are compressed) 

 Less chance of corrupted files (components are stored as separate entities, so if one piece is damaged, 
the rest of the document is still viable) 

 Better integration of business information (users can more easily assemble documents from various data 
sources, exchange data between Office and other systems, and publish, locate, and reuse information) 

 Interoperability (information can be used by any application that can read and write XML, not just Office 
apps) 

 Security (because of the transparent nature of the format, sensitive information can be readily identified 
and removed; the format also allows you to identify, isolate, and manage embedded code and macros) 

 Compatibility (the .doc, .xls, and .ppt binary formats are compatible with Office 2007 apps, and users of 
Office 2000/XP/2003 can install the Compatibility Pack so that they can open, edit, and save documents 
in the new formats) 

 Open and royalty-free specification 

 Easier integration (developers have direct access to specific contents within the file, like charts, 
comments, and document metadata without having to parse entire documents) 

This MSDN article covers various aspects of the new formats in some detail. 

Interface is redesigned to improve productivity 

Office 2007 offers what Microsoft is calling the fluent user interface, designed to achieve some pretty lofty design 
goals. The main challenge was to free users from having to thrash their way through the convoluted menu 
structure in an attempt to locate the commands, tools, options, and features needed to accomplish a particular 
task. 

The Ribbon replaces the menu structure and offers a context-sensitive display of options organized according to 
function. Along with the Ribbon come a number of other usability aids, including Live Preview, which gives users 
a look at the effect of various formatting options on selected text before they make any changes; the Mini Toolbar, 
which offers basic formatting buttons and hovers semitransparently over selected text; galleries, which are 
essentially prefab collections of attributes for certain items (like tables); and a customizable status bar with 
buttons for genuinely useful features. 
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App-specific enhancements add efficiency and power 

Apart from their interface-lift, Office 2007 applications provide some legitimate feature improvements that in many 
cases, will allow users to be more productive and produce better results. A few examples: 

 Word 2007 offers an enhanced document comparison feature lets you view original copy against revised 
copy in a tri-pane window; its Document Inspector finds and removes comments, hidden text, and 
personally identifiable information; it offers prefab building blocks (elements like cover pages and 
sidebars) to speed document assembly. 

 Excel 2007 has expanded its spreadsheet capacity to 1 million rows and 16,000 columns; charting is 
simplified; conditional formatting is easier to apply; new tools make it easier to discover trends and 
variances in your data. 

 PowerPoint 2007 lets you set up slide libraries on a SharePoint Server 2007 site and keep presentations 
synchronized with the slides stored there; you can design custom slide layouts; you can apply a theme to 
globally transform the appearance of a presentation. 

 Access 2007 includes new database templates to help you set up things like inventory tracking and 
project management; you can use new grouping, filtering, and sorting features to refine your reports; it 
includes some new field types. 

 Outlook 2007 offers a To-Do bar that shows you flagged e-mail and tasks; calendar sharing has been 
improved; an attachment previewer has been added; it includes support for reading and managing RSS 
feeds. 

New features make it easier to turn out better-looking results 8 

7 

Although improving productivity is high on the list of Office 2007 design objectives, a number of new tools and 
features are aimed at helping users produce more sophisticated and attractive documents and presentations. For 
instance: 

 Word's Quick Style sets make it easy for even style-phobic users to format document text consistently 
(instead of forcing them to choose from one monster list of unrelated styles or make ad hoc manual 
formatting changes). 

 The new SmartArt feature, which you can use in Word, Excel, PowerPoint, and Outlook e-mail messages, 
lets you create slick graphics to convey all kinds of information. 

 Word comes with a gallery of building blocks, which you can drop into a document to add preformatted 
elements like headers and footers, cover pages, sidebars, and pull quotes. 

 Access offers new templates for a variety of purposes and a greenbar format to make forms and reports 
sharper-looking and easier to read. 

 An enhanced set of themes—coordinated across Word, Excel, and PowerPoint—lets you develop a 
standard look and feel across all your documents and presentations. 

 Excel's charting features (supported in Word and PowerPoint) have been improved and include new 
special effects and templates. Excel also offers more color choices, richer conditional formatting, styles to 
simplify formatting tables, charts, and pivot tables, and a much improved implementation of cell styles. 

 PowerPoint allows you to create custom layouts and offers new text options, such as columns, wrapping, 
vertical text, and special effects (glowing, fills, 3-D, etc.). 
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Beefed-up user assistance reduces support overhead 

Office 2007 includes a considerable number of user support features. For starters, Enhanced ScreenTips 
generally provide more than just the name of a tool or button. In many cases, a ScreenTip will offer a picture or 
diagram, an explanation of the tool's purpose, and a link to relevant online help topics. 

Also, since the tools and features are designed to be more accessible and intuitive, users should be able to 
complete various tasks without requiring too many support calls (at least in theory). 

By default, the Office help system is tied into Office Online when users are connected to the Internet. (If that 
feature is disabled or they're not connected, they can still access the locally installed help files.) Along with topic- 
and task-specific help for each application, Office Online offers a wide variety of training and support options, 
including video demos, self-paced training courses, interface guides to help users map familiar commands to the 
new Ribbon locations, eLearning modules, downloadable training presentations, and a few experimental 
podcasts.  

Numerous deployment options are available 
Office 2007 supports a variety of deployment options, whether you need to install it on one system or hundreds  
(or even thousands) of systems. You can prepare disk images, deploy it on networks with limited bandwidth using 
precache technology, upgrade existing versions, or deploy it across an enterprise using Group Policy or Microsoft 
SMS 2003. 

10 
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In addition, Microsoft offers its Solution Accelerator for Business Desktop Deployment (BDD) 2007, which can 
help you perform large scale Office (and Vista) rollouts. Among other things, it lets you create software and 
hardware inventories to help in installation planning, test applications to confirm compatibility before installation, 
and create a lab environment. It also includes custom options, scripts, and sample configuration files. 

If you have a large number of old-format files, you might want to check out the free Office Migration Planning 
Manager (OMPM), which you can install on computers running XP SP2, Vista, or Server 2003. Once the OMPM 
is installed, you can use its Office File Converter to perform a bulk conversion of your old Office files to the new 
XML-based format. 
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Version 1.0 
June 7, 2007 

10 new Office 2007 interface elements 
(and what they're really called) 

By Jody Gilbert 

I've read a lot of early documents trying to sort out and describe the new 
Office 2007 interface. Not only has there been some confusion over 
where all the familiar stuff has gone and how to use the new stuff, but 
there have been rampant inconsistencies in terminology. So, for instance, 
the Office button has been variously called "the Logo button," "the Office 
icon," and "the big round control at the left end of the ribbon bar." 

To help clarify things—and possibly to facilitate clearer conversations 
about all these features as you help users get up to speed—I've listed 10 
major Office 2007 interface elements (using their Microsoft-given names). 

The Ribbon 
If you've seen Office 2007 (Word, Excel, PowerPoint, Access, or Outlook items such as messages), you know 
about the Ribbon. It houses tabs with functional groupings of buttons and drop-down lists that are supposed to be 
relevant to particular tasks. Some icons are bigger than others, engineered that way to add prominence to the 
most commonly used items. Below is the Ribbon that appears when you're in an Excel worksheet cell.  

If you find the Ribbon distracting or too space-consuming, toggle it out of sight using one of these methods: 

 Press CTRL-F1. 
 Double-click on any of the tab labels. 
 Right-click on the row of tab labels or any item within a tab and choose Minimize The Ribbon from the 

shortcut menu. 
 Click on the drop-down arrow at the end of the Quick Access toolbar and choose Minimize The Ribbon. 

Clearly, Microsoft saw that one coming. 

Tabs, contextual tabs, program tabs 
Each of the beRibboned apps initially displays a standard set of tabs, which vary depending on the application. 
For example, Excel's standard set of tabs (which you can see above) includes Formulas and Data, whereas Word 
offers References and Mailings. In addition to the standard tabs, you'll see specialized contextual tabs that appear 
depending on what you're working on. For example, if you insert a chart in Excel, the Chart Tools tab will appear, 
with Design, Layout, and Format subtabs, as shown below. 

 

1 

2 
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Incidentally, you may sometimes see more than one contextual tab. I was working with a picture in a table in a 
Word doc, and both the Table and Picture tabs appeared on my Ribbon. 

Tabs come with their own terminology, too: Each tab is divided into groups. So, for example, the Word Home tab 
below has groups called Clipboard, Font, Paragraph, Styles, and Editing. And certain groups (all but the Editing 
group in the Ribbon shown here) have dialog box launchers, those tiny icons in the bottom-right corner of the 
group. Click that icon and you get a traditional dialog box or task pane associated with the group. 

One more distinction to make 
regarding tabs: The Ribbon also 
sometimes displays program 
tabs. These are tabs that appear 
for certain views or authoring 
modes, such as Print Preview. 

The Office button 
Clicking the Office button displays the Office menu, which is 
sort of like the traditional File menu. It offers basics such as 
New, Open, and Save commands, along with some 
newcomers, like Prepare and Publish. In the figure to the right, 
I've purged the Recent Documents list (not that I have anything 
to hide), but it took awhile to find the option that controls that 
display. 

To save you some looking, here's the trick: Click Word Options 
(or Excel, PowerPoint, or Access Options) at the bottom of the 
menu and select Advanced. In the pane on the right, go to 
Display. You can enter the desired number in the Show This 
Number Of Recent Documents text box (0 to clear the list and 
keep it that way, and as many as 50 in Word, Excel, and 
PowerPoint. Access limits you to a maximum of nine.) Just click 
OK when you're finished. 

3 
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Galleries 
A gallery is a palette of 
prefab formatting 
attributes you can 
apply to various 
elements in Word, 
Excel, PowerPoint, 
and Access. Examples 
include tables, styles, 
charts, and 
PowerPoint themes, 
shown here. 

 

Live Preview 
Along with the gallery feature comes Live Preview, which is aptly named. When you move the mouse over the 
various selections in a gallery, your document takes on the formatting attributes of the current selection—just as a 
preview. So you can flit from one choice to another and try on the various sets of formatting without committing to 
anything until you're ready. In the image below, I was spinning through the offerings in the gallery of table styles: 
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The Mini Toolbar 
The Mini Toolbar is a ghost toolbar that appears when you select text. It hovers there in the ether unless you 
move the mouse pointer over it, when it materializes with several buttons for common text formatting tasks. Move 
off it or click somewhere else, and it disappears. 

 

Enhanced ScreenTips 
When you move the mouse pointer over items in the Ribbon, you'll see Enhanced ScreenTips. These ScreenTips 
will probably come in handy for novice users and those who are learning the Office 2007 ropes. More experienced 
users may not pay much attention to them, although in some cases, they should. For example, if you forget you're 
working on a document in Compatibility Mode (as I did), you might otherwise be confounded if you run into limited 
functionality. The ScreenTip shown here serves as a useful reminder.  

Not all ScreenTips are this colorful or 
verbose. Some offer the feature 
name and a terse description and 
possibly a keyboard shortcut.  

If you don't like the ScreenTips, you 
can suppress them or eliminate the 
"Enhanced" characteristics. Choose 
Options from the Office menu and 
under the Popular settings, choose 
either Don't Show Feature 
Descriptions In ScreenTips or Don't 
Show ScreenTips. 

 

The Quick Access Toolbar 
The Quick Access Toolbar is by no means an innovation. Still, I'm 
relieved to have it in the Office 2007 interface because it can serve 
as a customized toolbar that's similar to ones I've always used in 
earlier versions. The Quick Access Toolbar, shown here, displays 
only above or below the Ribbon (no undocking or minimizing). 
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The Quick Access Toolbar comes with a set of basic, frequently needed buttons to get you started. At the right 
end, you'll find the Customize Quick Access Toolbar drop-down arrow, which gives you a list of other frequently 
needed buttons, such as Undo, Print Preview, and Spelling & Grammar. Just select what you want from the list 
and they'll appear on the Toolbar. The better news is that you can also choose the More Commands option from 
the list to access all commands, including those not found anywhere on the Ribbon, as well as any macros you 
might want to have handy. 

KeyTips 
I don't want to editorialize excessively here, and I should point out that the traditional Office keyboard shortcuts 
(CTRL-C, SHIFT-F3, etc.) work as they've always worked. And KeyTips—designed to serve as keyboard 
accelerators to access various items on the Ribbon—are sound in principle. You press ALT and then you press 
the appropriate additional keys as indicated by the KeyTips labels. But I'm not entirely convinced that this 
implementation is going to be all that well received. Here's an example: 

 

The status bar 
Okay, you already know the name of this one--and miracle of 
miracles, it's still in the same old spot. But it's a status bar on 
steroids, so you should be aware of its new trappings. By 
default, the Office 2007 status bar offers options such as a 
Zoom slider for magnification and view options (Draft, Print 
Layout, etc.). The options vary by application. 

But here's the best part: You can customize what appears on 
each application's status bar. Just right-click on it and you'll 
see the Customize Status Bar menu, shown here. It lists 
everything you can place on the status bar, along with its 
current state. 
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10+ ways to train your users Version 1.0 
June 11, 2007 on Office 2007 for free

By Tiffany Songvilay 

Buried deep within the sitemap of Microsoft.com are lots of options for training your users on Office 2007. But 
ever since the incredible Mr. Clippit, users have been quick to shrug off Microsoft help, and IT has had to reinvent 
the Office Fundamentals Training Wheel. Here are some tips for getting the most out of free Microsoft tools to 
help you educate and support your users. 

 

Links to tip sheets and articles 

Instead of telling your users to go out to Microsoft.com and do a search for Word 2007, put hyperlinks to the 
printer-friendly version of tip sheets and articles like Word or Publisher? Which one should you use? on your 
company’s main portal page. Providing links to information you know they need will help you cover the training 
bases. Presenting the links on an internal Web site they already use will show your users that it’s okay to go 
outside of their four firewalls to learn something new. Include your favorite hyperlink in your signature line so it 
goes out in every e-mail you send. 

Online training 

Office online self-paced training courses are a great way to link your users to 30- to 60-minute onscreen, clickable 
demos to walk them back through the steps you just took them through over the phone or as a replacement to 
that step-by-step e-mail you always take the time to write. 

Since these demos do have sound, remind them to turn their speakers on or put on their headphones before 
following the link. These videos do not require multiple clicks to get to the start of the course nor do they require a 
logon with a Windows Live ID. As a point of reference, these are the same demos that are returned via the Help 
menus in Office. Common problems are broken up into one- to two-minute increments so that it’s easy for users 
to pause the course and rejoin it later. So, for instance, the next time someone complains that they’ve hit their 
size limit in Outlook, send them this link: How to clear away the clutter in your Inbox. 

E-Learning 

Microsoft E-Learning includes free, self-paced, onscreen fundamentals training courses for Live Meeting, Groove, 
Windows Vista, and the Office 2007 user interface. Users must log on with their Windows Live ID, but no ActiveX 
controls are required. Navigation is explained in the introduction to each course. 

You might also want to check out the free courses for IT professionals listed in the course catalog at the top of the 
screen: BizTalk Server 2006, SQL Server 2008, and Security Guidance training. Don’t forget to find the word 
FREE on the Developer Catalog page as well. 

Webcasts 4 

3 

2 

1 1 

Live and On-Demand Webcasts also require a Windows Live ID; however, there is a new Web viewer for 
LiveMeeting that allows users to view the webcast on demand without downloading LiveMeeting, which is key in 
the managed PC environment. Users won't be able to download the Windows Media file for offline viewing of an 
on-demand webcast from a managed PC, but check with your Microsoft rep (see Tip #7). They typically have 
some of these webcasts available for you on a DVD to upload into your training tracking system, if you want to 
make watching one or more of these webcasts required for your users.  
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Virtual training 

Virtual Labs are admittedly not for the average user, but they can prove useful in teaching your SharePoint 
designers and help desk staff. These labs do require ActiveX controls to run, so take care not to recommend 
these labs to users unless Virtual Server VRMC Advanced Control and Virtual Machine Remote Control 
Advanced ActiveX are in your standard PC build. A lab manual is available with each course and it connects you 
to a clickable Virtual PC environment. Disregard the Office 2007 First Look labs, since they were built on Beta 2, 
but scroll down to find gold in What's New in Microsoft Office SharePoint Server 2007 Feature Walkthrough Virtual Lab. 

Partner events
In-person events mean going offsite, and besides submitting an expense report for the extra 3.26 miles you had 
to drive to get there, it is a great way to send a couple of your favorite users in any department to learn about 
solutions and ideas on how to leverage the software your company already owns. I especially recommend this 
site around Administrative Professionals Week. Instead of taking the boss’ assistant out to lunch, send him or her 
an invitation to a Microsoft event that is sure to yield free lunch and swag. (Pssst: Administrative Professional 
Week is in March.) The IT human that always knows where to get branded stress balls is the IT human with the 
most stress balls. And I think we can all agree that when we’re back at the office at 2 o’clock in the morning on a 
weekend to oversee a data transfer, nothing comforts you like squeezing a cleverly shaped stress ball. 

Trucked-in training 

If you followed the partner event link in the previous tip, you might have noticed the Microsoft Across America Truck 
as one of the options. If your company is a Microsoft partner, you can book this truck. If you’re not a Microsoft 
partner, encourage your Microsoft rep or third-party solutions provider to host an event. As a partner, it's a great 
way to gather new leads; as a customer, it's an opportunity for you to talk to industry experts and service 
providers about solutions you need to manage your Office 2007 rollout. 

Microsoft Marketing Events 

If you don’t know who your company’s Microsoft representative is, you can go to the Microsoft U.S. Office Locations 
page to find the Microsoft office closest to you. Then, just call and ask to talk to the IWSS (Information Worker 
Solutions Specialist) for your district. IWSSes are given corporate resources to deliver onsite events to their 
clients. 

For example, a "Tips and Tricks" team is available to present 60- to 90-minute scenarios at your location, and 
most offices have a TS (Technology Specialist). The TS is tasked in part with visiting clients and creating these 
types of events for their clients. While there is no cost to you, there is typically an attendance minimum of 60 
people per day to justify Microsoft’s cost of sending a presenter, and it’s all rolled up into the benefits of being an 
Enterprise customer. What types of seminars do they present? Follow the webcast link in Tip #4. Most of those 
topics can be delivered at your location. 

Multilingual ScreenTips and translations 9 
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7 

6 

5 

¿No habla Inglés? For many international companies, rolling out Microsoft software worldwide is a daunting task 
due to language barriers and the lack of training materials available in foreign languages early in the software 
lifecycle. Fortunately, translation assistance is available. 

Open up a Word 2007 document and right-click anywhere on the page. Click Translate and then chose Arabic, 
French, or Spanish. Give it a moment to activate, and you should be able to scroll over any word in the document 
and get a ScreenTip that translates the word for you and gives you a definition in the language you selected. 
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Still not satisfied? Right-click and choose Translate from the shortcut menu. Choose the language you want to 
translate the document from and then the language you want to translate the document to. Click the green arrow 
under Translate The Whole Document. When you see a message telling you that you’re being sent to Word Lingo, 
click Yes. This is a free Internet service that has been available from the Research pane since Office 2003.  

Command Reference Guides
If you do nothing else for yourself, include this link in your signature line and don’t call it a command reference 
guide when you do. Name it something like “Where have all my toolbar buttons gone?!” These interactive 
reference guides show an Office 2003 toolbar. When users click on a familiar button, the screen fades to an 
Office 2007 screen and highlights where that button is on the Ribbon. For users who complain about the time they 
waste each day looking for things like Print and Spell Check, this tool will eliminate their frustration with the 
Ribbon. If you make one item mandatory for all  training classes and corporate communications, let it be this one. 
Make sure every user knows it's out there BEFORE you push Office 2007 to their PC. 

Office Online At Work

10 

11 
One final tip as we round out the list of training options. Remember that when you reference Microsoft.com, you 
are referring to a lot of things that don’t apply to your users. Remove Microsoft.com from your IT reference guide 
and replace it with office.microsoft.com. Go out to this site every day, and you'll see that it is not a static page. The 
pictures and links change daily as new content is added and refreshed. I included the At Work link above because 
it has plenty of resources to tire out your busiest busybody. This is the link to include in your Out of Office 
Assistant message when you finally get go on vacation once the rollout is complete. 

 

 

 

 
Tiffany Songvilay is a Microsoft Office Specialist and co-author of So That’s How! 2007 Microsoft Office System: 
Timesavers, Breakthroughs, & Everyday Genius. She has presented productivity scenarios at Microsoft’s 
Convergence, ITEC Conference and Exhibition, and for IAAP. Currently engaged as a business analyst for 
Microsoft Enterprise customers, she designs and implements training plans that help companies transition their 
workforce smoothly into new technology. Her Office Over Easy blog covers a variety of IT and end users issues. 
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10 things you should know 
about Office 2007 compatibility issues 

By Debra Littlejohn Shinder 

Microsoft Office 2007 provides a lot of new features and functionality, but what about compatibility? Here are 10 
tips for dealing with compatibility issues when you upgrade to the latest versions of Word, Excel, PowerPoint, and 
Outlook. 

#1: Understanding and using new file formats 
All the Office 2007 programs use new default file formats based on the Extensible Markup Language (XML). The 
new formats are indicated by an "x" in the file extension. For example: 

• Word documents: .docx 
• Excel workbooks: .xlsx 
• PowerPoint presentations: .pptx 
 

XML is an open standard, and the change makes it easier to move files between different applications. It also 
makes file sizes smaller than those saved in the old binary formats. However, some users with previous versions 
of Office may not be able to open files in the new formats.  

You can still save files in Office 2007 programs in Office 2003 file formats. Just select Word 97-2003 Document 
(*.doc) from the Save As Type drop-down list in the Save As dialog box, as shown in Figure A. 

 

Figure A: You can easily save individual files in the old Office 2003 formats. 
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#2: Changing the default format 
If you want to always save files in the old format by default, click the Office button, then the <program name> 
Options button, and select Save in the left pane. Choose Word 97-2003 Document (*.doc) from the Save Files In 
This Format drop-down list, as shown in Figure B. 

 

Figure B: You can set the default to always save files in the old Office 2003 format. 

When you save a file in the old format that was originally created in the new format, you may get a message 
advising that some of the formatting and features that are only supported by Office 2007 programs will be lost. 

#3: Using Office 2007 compatibility mode 
Office 2007 programs introduce a new feature called compatibility mode. If you frequently share files with others 
who haven’t upgraded or you need to work on your files on another computer (for example, a laptop) that doesn’t 
have Office 2007 installed, you can ensure that the files you create in Office 2007 don’t contain any features that 
aren’t supported by the previous version of the Office program. 

If you place your Office 2007 applications in compatibility mode, incompatible features, such as the SmartArt 
diagramming tool, won’t be available to you. Instead, you’ll use the diagramming tool from Office 2003 so that the 
diagrams you create can be edited in the older version of the program. 

Compatibility mode is automatically on when you open a file that was saved in the old file formats, when you 
convert a file from the XML-based format to the older format, or when you configure the program to save to the 
old format by default. In Word, compatibility mode also kicks in if you create a new document from an old-format 
template (.dot).  
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When the Office 2007 program is in compatibility mode, it will be indicated in the document title bar, as shown in 
Figure C. 

 

Figure C: Office Compatibility Mode is indicated in the title bar of the document. 

Some features can be returned to the document if you reopen it in an Office 2007 program; others can’t. For a full 
list of the features that are lost when you work in compatibility mode and which ones can be refreshed, see the 
article "Compatibility Mode in the 2007 Office System" on the Microsoft TechNet site.  

#4: Installing the Office 2007 Compatibility Pack 
If someone with whom you exchange files is still running an older version of Office and you want to be able to 
send them files in the new XML formats (for instance, so they can see the formatting features that are unique to 
Office 2007), they can install the Office 2007 Compatibility Pack. 

The Compatibility Pack allows users of Office XP or Office 2003 to open, edit, save and even create files in the 
new XML-based formats. The pack is available as a free 27.1 MB download from the Microsoft Web site. It can be 
installed on machines running Windows 2000 SP4, Windows XP SP1, and Windows Server 2003. 

#5: Using the OMPM File Converter 
If you have a large number of Office files saved in the old format that you want to change to the new XML-based 
format, you don’t have to open and save them one at a time in the Office 2007 program. Instead, you can perform 
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a bulk conversion using the Office File Converter that’s included in the Office Migration Planning Manager 
(OMPM).  

The OMPM is a free 2.7 MB download available from the Microsoft Web site. It can also be used by administrators in 
organizations to scan and generate reports about the Office files on the network. You can install it on computers 
running XP SP2, Vista, or Server 2003. 

Once the OMPM is installed, to perform bulk file conversions you use the OFC.EXE tool at the command line. 
You’ll need to create an ofc.ini file with settings defining what you want to convert. Microsoft provides a template 
for the ofc.ini file that you can edit to indicate the path for the folders you want to convert. For more information on 
the contents of the ofc.ini file and how to invoke it programmatically, see "Converting Office documents to Open XML." 

#6: Viewing PowerPoint presentations with PP Viewer 2007 
PowerPoint 2007 provides many cool new graphical features that aren’t supported by older versions of 
PowerPoint. These presentations can be viewed by Office XP/2003 users with the Compatibility Pack installed, 
but what if you want to see a presentation on a computer that doesn’t have any version of Office installed? 

You can use the PowerPoint Viewer 2007 to view these presentations will all the new features intact. It also 
supports opening presentations that have been password-protected in PowerPoint 2007 -- however, it does not 
support viewing presentations that have been protected using Microsoft Information Rights Management 
technology.  

The Viewer is a free 25.8 MB download available from the Microsoft Web site. It can be installed on computers running 
Windows 2000 SP4, XP SP1, Vista, and Server 2003. 

At the time of this writing, viewers for Word and Excel 2007 were not yet available. But you can use the Word and 
Excel 2003 viewers to view Word and Excel 2007 files if you install the Compatibility Pack. For details, see KB 
article 925180, "How to view Word 2007 and Excel 2007 files by using Word Viewer 2003 and Excel Viewer 2003." 

#7: Using the Compatibility Checker 
Before you send a document that was created with 
an Office 2007 program to someone who’s using a 
previous version of Office, you can run the 
Compatibility Checker, which is built into Word, 
Excel, and PowerPoint 2007. It will identify any 
features or formatting you’ve used that won’t be 
recognized by older versions of Office.  

A list of the incompatible content will be displayed, 
and you’ll be advised that such content may not be 
fully editable in the previous version. The 
Compatibility Checker runs automatically when you 
save a file in the old format. You can also run it 
manually from the Office | Prepare menu, as shown 
in Figure D. 

 

 

 

 

 

 

 

Figure D: You can run the Compatibility Checker 
from the Office Logo | Prepare menu. 
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#8: Outlook 2007 and Exchange 5.5 
Outlook 2007 works only with Exchange 2000 or later. Users who attempt to connect to an Exchange 5.5 Server 
will get a message that Outlook is unable to log onto the Exchange server. Extended lifecycle support for 
Exchange 5.5 ended in January 2006, and Microsoft intentionally designed Outlook 2007 to prevent it from 
connecting to Exchange 5.5 servers to avoid data loss and other problems that were anticipated with this 
combination. 

Be sure you know what version of Exchange server your organization is running before you update to Outlook 
2007. 

#9: Office 2007 file formats and mobile devices 
The new XML-based file formats can't be opened with current Pocket Office programs on Windows mobile 
devices running Windows Mobile 2003 and Windows Mobile 5.0. The newest version, Windows Mobile 6, 
supports the XML-based file formats.  

Microsoft is expected to release an update for Windows Mobile 5 in mid- or late 2007 that will allow it to open 
Office 2007 documents, but those still using WM2003 devices are apparently just out of luck. 

#10: Adding on a "classic" user interface 
Although not exactly a compatibility issue, many users find Office 2007’s new user interface incompatible with 
their way of doing things. The Ribbon replaces the old-style menus, and while this new tabbed Ribbon seems to 
be easier to learn for new users (who haven’t used previous versions of Office), many longtime Office users have 
complained that they miss the old menus. 

If you want, you can install a third-party add-on that gives you back the old menu bar without sacrificing the new 
Ribbon. Classic Menu for Office 2007 installs easily and costs $29; it’s available from www.addintools.com. After it’s 
installed, an extra tab appears on the Ribbon called Menus, as shown in Figure E. 

Figure E: If the new Ribbon interface is incompatible with the way you like to work, you can add back the Classic 
Menu. 

Debra Littlejohn Shinder is a technology consultant, trainer and writer who has authored a number of 
books on computer operating systems, networking, and security. These include Scene of the 
Cybercrime: Computer Forensics Handbook, published by Syngress, and Computer Networking 
Essentials, published by Cisco Press. She is co-author, with her husband, Dr. Thomas Shinder, of 
Troubleshooting Windows 2000 TCP/IP, the best-selling Configuring ISA Server 2000, and ISA 
Server and Beyond.  
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10 ways you can tweak Word 2007 
to fit your working style 

 

By Katherine Murray 

The latest version of Word provides a number of ways to tailor the program so that it fits your style of doing things. 
Here's a look at 10 techniques for customizing the look, feel, and function of Word 2007. 

#1: Hide the Ribbon 
The earliest reactions to 
Word 2007 have been 
mixed—some people love 
the look of the new Microsoft 
Office Fluent interface (the 

formal name for the new 
design, which includes the 
Ribbon), and others, not so much. It seems that the most resistance has come from experienced Word users, 
people who were happy with their familiar set of shortcut keys and customizations. 

Figure A 

One complaint has been that the Ribbon is a little too space-consuming. If you prefer to have more working room 
on the screen than Word 2007 offers by default, you can hide the Ribbon by pressing Ctrl+F1. This reduces the 
Ribbon to only the tab titles, so the commands are within reach if you need them (Figure A).To return the Ribbon 
to normal display, press Ctrl+F1 again. 

#2: Customize the Quick Access Toolbar 
The Quick Access Toolbar is the small toolbar that appears to 
the right of the Microsoft Office button in the upper-left corner of 
the Word 2007 window. This toolbar provides access to 
commands you are likely to use often. By default, it displays 
only Save, Undo, and Redo. You can easily change the 
commands that appear in the Quick Access Toolbar so that it 
contains those you use regularly. For example, if you frequently 
check spelling and grammar in your documents (not a bad 
idea), you may want to add the Spelling & Grammar command 
to the Quick Access Toolbar. To add a command, click the 
arrow to the right of the Quick Access Toolbar. The drop-down 
list shown in Figure B will appear, showing you the most 
common additions. Click the item you want to add (or click More 
Commands to see additional options) and Word will add the 
command to the toolbar. 

#3: Display and use KeyTips 
KeyTips provide you with a display of the keys you can press if 
you want to navigate through Word using the keyboard instead 
of the mouse. Press Alt to display KeyTips on the Ribbon. You’ll 
see small boxed characters appear on the major tabs and Quick Access tools in the Word window. When you 
press one of the characters (for example, pressing I selects the Insert tab), you'll see that all commands on the 
Ribbon have their own KeyTips. KeyTips will remain on the display until you press Alt a second time to hide them. 

Figure B 
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#4: Tailor the status bar 
The status bar in Word 2007 has a new level of, uh, status in 
Word 2007. You can get more information than ever, simply by 
right-clicking anywhere on it. When you do, a popup list of 
available items will appear (Figure C). At a glance, you can see 
helpful things like word count, spelling status, and whether Track 
Changes is enabled. 

But the real purpose of the Customize Status Bar list is to enable 
you to choose the items you want to see displayed on the status 
bar. You can add Caps Lock, for example, if you want to see an 
indicator when you’ve accidentally pressed the Caps Lock key (or 
forgotten to toggle it off). To add an item that's not currently 
displayed, just click it. To hide something you don’t want 
displayed in the status bar, click the item to remove it. (Displayed 
items appear with checkmarks in the Customize Status Bar list.) 

#5: Change the color of Word 
You don’t have a huge range of vibrant colors to choose from 
when you want to customize the overall look of the Word 2007 
window, but you do have a few options. To change the color of 
the interface, click the Microsoft Office button and choose Word 
Options. In the Popular window, click the Color Scheme down 
arrow. Blue is selected by default; you can also choose Silver or 
Black. (I know, yawn.) Take heart, though—you can wake 
yourself (and your readers) up with plenty of color by applying 
Themes and Quick Styles to your actual documents. 

Figure C 

#6: Modify ScreenTips 
Word 2007 includes Enhanced ScreenTips that give you more information about Word commands and 
procedures. This is helpful when you need to find a command to do a particular thing and can’t quite remember 
what various commands do. (For example, what is the difference between a citation and a cross reference?) 

When you point to a command on the Ribbon, 
Word displays a ScreenTip to give you the 
basics of the command. By default, Word gives 
you lots of information. But you can shorten 
the ScreenTips if you feel you need only little 
nudges now and then, or do away with them 
altogether. To change the way ScreenTips 
appear, click the Microsoft Office button and 
choose Word Options. In the Popular window, 
click the ScreenTips Style down arrow and 
choose the option you want. Click OK to save 
your changes. 

#7: Create keyboard shortcuts 
If you’re a diehard shortcut key fan, you're 
probably eager to create your own shortcut 
keys in Word 2007. To do that, click the 
Microsoft Office button and choose Word 
Options. Click Customize and then click the 
Keyboard Shortcuts button at the bottom of the 
window. In the Customize Keyboard dialog box 
(Figure D), choose the tab containing the Figure D 
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command you want to automate. Then, in the 
Commands list, select the command name. (Notice that 
these names are the command names as they are 
known in the program—not as they appear in the 
Ribbon.) Press the shortcut key you want to assign to 
the command and click Assign to save the new shortcut 
key. Click OK to close the Word Options dialog box, 
and the new shortcut key should be in effect. 

#8: Start Word automatically 
You can easily have Windows Vista launch Word 2007 
at startup by copying Word into your Startup folder. 
Here’s how. Click the Windows Start button and choose 
All Programs. Click Microsoft Office to display the 
programs in that folder. Right-click Microsoft Office 
Word 2007 and choose Copy. Now scroll down to the 
Startup folder in the All Programs list, right-click on it, 
and choose Explore (Figure E). When the Startup 
window opens, press Ctrl+V to paste the Word 2007 
shortcut you copied into the folder. Now, close the 
Startup window. The next time you start Windows, 
Word will start automatically.  

#9: Launch Word and open a 
particular document 
If you want Word to open to a specific document each 
time the program starts, you can use a switch to tell 
Word which document you want to use. First, click the 
Windows Start button and select Run. Then, type the 
path to Word (for example, C:\Program Files\Microsoft 
Office\Office\Winword.exe), press the spacebar, and 

type the switch /t, followed by another space and the 
name of the file you want to open. If you really like 
starting Word this way, you can create a desktop shortcut for it by right-clicking your desktop, choosing New, 
clicking Shortcut, and entering the path and switch in the Location box in the Create Shortcut dialog box. 

Figure E 

#10: Change where your documents are stored 
You can tell Word to save your documents in a folder of your choosing by clicking the Microsoft Office button, 
choosing Word Options, and clicking Save. In the Save options, click the Browse button to the right of the Default 
File Location box and navigate to the folder where you want to store your documents. Click OK to save the 
location and close the dialog box and click OK a second time to return to your document. 

 

 

 
Katherine Murray is the author of many computer books (including the in-the-box documentation for Microsoft 
Office 2007 Professional and Small Business Editions). She also writes digital lifestyle articles for various 
Microsoft sites and publishes a blog called BlogOffice that shares Microsoft Office ideas, how-to's, and tips. 
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Version 1.0 
June 12, 2007 10 Word 2007 features you can skip 

By Katherine Murray 

Word 2007 is full of new tools and options, expanded capabilities, and significant changes. Find out what to focus 
on and what you can leave for another day (or month, or year...). 

#1: The Font dialog box 
Thanks to the new Themes feature (which is a great addition to 
Word 2007), you can skip working with the individual effects that go 
into controlling the format of your document. Themes include 
predesigned settings for colors, fonts, and effects, and things like 
sidebars and quotes have their own styles as well.  

Just choose the Page Layout tab, click the Themes arrow, and 
select the theme you want from the gallery, shown in Figure A. 
The design will be automatically applied. If you want to change the 
theme later, simply return to the Themes gallery and make another 
choice. (If you want more granular control, you can still display the 
Font dialog box by clicking the dialog launcher in the lower-right 
corner of the Font group in the Home tab.) 

#2: Mark As Final 
The Mark As Final feature in Word 2007 (available when you point 
to Prepare after clicking the Office button) has potential, but in this 
version of Word, it doesn’t pack a lot of punch. Even though you 
can mark your current document as final, when someone else 
receives the document, he or she can simply make a copy and 
then edit it as usual. If you want to ensure that nobody is going to 
change your content or alter your formatting, save the document as 
a PDF or XPS file instead. 

#3: Save As Word XML 
XML in Word 2003 was kind of a patch job. As XML became more 
widely used, developers knew they needed to include a way for 
Word users to save files in XML format and use XML data in their 
Word documents. The attempt to add XML to Word 2003 created 
huge, clunky files that you had to save intentionally in XML format 
by using the Save As XML command. 

Although you can still, if you choose, save a file in that old Word 
XML format, trust me—you won’t want to do that. Today’s Word is completely built on Office OpenXML, so now all 
the files you create and save in Word 2007 are actually saved in XML. 

Figure A 

What does this mean to you? The short answer is that resulting files are much smaller and cleaner. The longer 
answer includes better security and reliability and an easier exchange with other applications (including nearly 
seamless integration with SharePoint sites). 

The only downside to the new format is that it is incompatible with pre-2007 versions of Word, so to send a 
document to a Word 2003 user, you still have to use Save As and save the file in the Word 97-2003 format (or 
simply send your coworker a link to the Word 2007 conversion utility, available free of charge on the Microsoft 
Downloads site). 

#4: Mail Merge Wizard 
If you like programs to walk you through every step of a process, you may be fond of wizards. But in Word 2007, 
the whole mail merge process has been given higher visibility (thanks to lots of feedback from Word users about 
mail merge frustrations) and assigned its own tab in the Ribbon. Now you can work through your mail merge 
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projects, whether they are simple or complex, by simply following the selections on the Mailings tab (Figure B). If 
you still want to consult the wizard for a little extra support, you’ll find it by clicking the Mailings tab, choosing Start 
Mail Merge, and selecting Step By Step Mail Merge Wizard at the bottom of the command list. 

Figure B 

#5 Drawing Canvas 
The Drawing Canvas was a big deal in earlier versions of Word, but it’s a bit of a dinosaur in Word 2007. In this 
version, it is so easy to draw, arrange, group, and work with shapes and images in your Word documents that the 
Drawing Canvas really isn’t needed to tie everything together the way it once was. Now you can assemble your 
shapes directly on the document, group them, and work with them as a single object. The Drawing Canvas has an 
annoying way of bumping everything on your document to another place on the screen, and for most custom 
drawings I do in Word, I prefer to draw directly on the page. 

#6: Signature Line 
Tucked away in the Text group of the Insert tab in Word 2007, you’ll find the Signature Line command. This is 
another one of those features that has potential but doesn’t carry a lot of clout. When you first click Signature 
Line, a popup message box appears, warning you that although you can use a digital signature to help identify the 
authenticity of a document, this type of signing may or may not hold up in court. The message points you to digital 
signature services on Windows Marketplace, where you can find digital services that pack a bit more punch. 

#7: Web Tools 
Are you wondering where Web support went in Word 2007? Although Web Layout view still exists in Word 2007, 
a number of the Web tools have been removed. For example, there’s no longer support for adding movies or 
sound to your Web page (those commands used to be on the Web Tools toolbar), and many of the browsing 
buttons you could use while working in Word have been removed. (If you want, however, you can add in some 
navigation controls by displaying Word Options, choosing Customize, and selecting All Commands.)  

You can still save a document as a Web page and view it in Web Layout view so that you know what it will look 
like when you save it. But for more detailed Web work, you may want to check out Microsoft Expression Web, the 
new replacement for FrontPage. Another alternative is to use the (awesome) new blogging feature to publish your 
thoughts directly to a blog. You’ll find Word 2007’s blogging capability tucked away in the Publish options. Click 
the Office button, choose Publish, and click Blog to get started. 

#8: Document Map 
Okay, well, this one is a bit of a red herring. I wouldn’t suggest that you skip the Document Map if it’s a feature 
you use often, because it’s actually one of my favorite ways to navigate (and review) long documents in Word. But 
if you like quick and easy methods for reviewing your long documents, you’ll love the new Thumbnails view 
(Figure C). Now you can look over the section headings in Document Map and then switch to Thumbnails view 
(click the View tab and click Thumbnails in the Show/Hide group) to get a miniature view of each page in layout 
form. This enables you to see how your document flows, check the placement of tables and pictures, and just 
generally get a feel for whether your document is ready to roll. 

#9: Microsoft Clip Organizer 
This may be personal opinion shining through, but it’s hard to imagine that the Microsoft Clip Organizer really 
makes anybody’s life easier. The process for searching for and adding pictures and clipart is seamless in Word 
2007, and the increased prevalence of DSL and T1 connections makes grabbing images online easier than ever. 
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Unless your job (or your hobby) 
requires you to gather huge 
collections of images that you are 
sure you will use again later, why 
take the time to set up, sort through, 
and manage all those image files in 
Microsoft Clip Organizer? (If you’re a 
media file maven, consider 
switching to Windows Vista—the 
media file management features 
alone make it worth the stress of 
upgrading.) 

#10 Document 
Properties 
By clicking the Office button, 
choosing Prepare, and clicking 
Properties in Word 2007, you can 
display the Document Properties 
area at the top of your document 
and enter information about the 
file—such as your name, the title, 
the status, and a brief description. 
That’s fine if you have a lot of time 
to kill and don’t expect other people 
to actually read the document. But if 
you simply want to make sure the 
author’s name appears on the doc 
and that it's tagged appropriately so 
you can find it again later in a 
search, you can do that quickly and 
easily when you save the file. To 
add the author’s name and tags, 
simply click in the respective boxes 
in the Save As dialog box, shown in 
Figure D, name the doc, and save it 
by clicking Save. Easier and faster, 
with fewer keystrokes. Nice. 

Figure C 

 

 

 

 

 

 

 
Figure D 
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Version 1.0 
June 7, 2007 10 key enhancements in Excel 2007 

 

By Craig Stinson 

Given the learning hurdle that comes with an entirely revamped (albeit improved) user interface, Excel 2007 must 
offer significant enhancements to encourage you to upgrade. Herewith, my top 10. 

Make the Ribbon work for you 
The Office 2007 redesign includes some radical new interface elements aimed at making it easier find the 
features you need and execute tasks more efficiently. The most prominent of these new elements is the Ribbon, 
which offers task-oriented tabs with commands readily available instead of hiding in a menu structure. 

For some users, this will definitely be an enhancement, but it's hard for others to see past the changes. 

From the absence of a "classic mode" in Excel 2007 (and the other Office programs that use the Ribbon), one 
could draw either of two conclusions: 

 Microsoft was so sure the Ribbon UI would be a boon to mankind that it didn’t think anyone would care to 
look back 

 Microsoft was so nervous about Ribbon adoption that it didn’t dare give us a way to look back.  

Whichever it is, many users are finding that mastery of the new interface is a slow go. Here are some ways to 
mitigate the pain. 

First, keep Microsoft’s Interactive Excel 2003 to Excel 2007 command reference guide close at hand. With this 
handy tool, you can click on an old-style menu command and read a tip describing the Ribbon equivalent (Figure 
A). To get to the guide from within Excel, click the Help button and enter interactive in the Search field. If you use 
it regularly, open it in your Web browser, then drag the icon to the left of the URL in the browser’s Address Bar to 
your Quick Launch toolbar or desktop. You might even want to install Microsoft's Get Started Tab for Excel. It's a 
free download that places a Get Started tab on the Ribbon, with options for accessing demos, online tutorials, 
videos—and the aforementioned Interactive Command Reference Guide. 

Figure A 

Want a more permanent set of training wheels? Install the Excel version of Classic Menu for Office 2007 (See 
"Add Office 2003 tools and menus to your Office 2007 interface" for more details). This add-in makes a great 
learning tool, and if you really hate the Ribbon you can use the add-in exclusively. 

Finally, if you liked to customize the old menu system and miss the ability to do that in Excel 2007 (we don’t count 
the Quick Access Toolbar as a proper customization tool), check out Patrick Schmid’s RibbonCustomizer. This 
add-in lets you rearrange the Ribbon by filling out a simple dialog box; no programming is required. 
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Figure B 

Create consistent, appealing formats with styles and themes 
Styles, always the smartest way to format Office documents (because they let you change your mind 

without having to reformat every heading and table), have not always been the easiest way. That’s changed now. 
Excel 2007 offers several kinds of styles, including cell styles, table styles, chart styles, and PivotTable styles. 

Cell styles provide a quick way to emphasize "good," "bad," and "neutral" values (see also the new conditional 
formatting features, described below), as well as to distinguish the functional sections of a worksheet (data from 
calculations, for example). Table, chart, and PivotTable styles (which appear on the Design tab when a table, 
chart, or PivotTable is selected) can make your work presentation-worthy with a single click. 

Because styles are linked with the set of display themes shared by Word, PowerPoint, and Excel, they can also 
help you create a consistent look to your work—consistent within itself and consistent with your company’s design 
guidelines. 

Build bigger, more capable, worksheets 
It’s certainly possible that the old worksheet capacity—65,536 rows by 256 columns (16,777,216 cells) was quite 
enough. But just in case, Excel 2007 has expanded to allow 1,048,576 rows and 16,384 columns (a whopping 
17,179,869,184 cells). If you import from large corporate databases, you might actually find the new limits 
invaluable. And even if you don’t, there are plenty of other increases to enjoy. To name just a few: When sorting, 
you’re no longer limited to three fields; you can specify up to 64. You can now stuff as many as 10,000 characters 
into a formula (a tenfold increase), and your functions are no longer limited 30 arguments (with the new limit of 
255, they can argue till they’re blue in their faces). Formulas are also no longer restricted to seven levels of 
nesting (the new limit is 64). 

Check out Excel’s new conditional formatting features 
With cell styles, you can mark bad or good values statically. With conditional formatting, you can do 
it dynamically, so that, for example, spending figures turn red only when they exceed associated 
budget values. 

The conditional formatting features are significantly easier and more versatile in Excel 2007. You 
can do more without writing formulas. For example, menu picks now let you flag such conditions as 
"top 10 %" or "Above Average." And there are some nifty new display options. With data bars, for 
example, your numbers can appeal to the left and right brain hemispheres simultaneously, and in 
the same column (Figure B). With color scales you can create “heat" diagrams—e.g., red for high 
numbers, green for low ones. With icon sets you can flag values with traffic lights, arrows, and other 
easily recognized symbols. 

Turn ranges into tables 
Pressing CTRL+T within a worksheet range turns that range into a table, a formal entity that’s mostly new in Excel 
2007. (Excel 2003’s list was a weak forerunner.) Tables offer several advantages over ordinary ranges. 

 You can apply styles to them that do such things as apply horizontal banding—formatting that alternates 
by row so your eye can more easily follow a row across the table. If you did this (manually) in the past, 
your banding turned to hash as soon as you sorted the range. Now it stays put no matter what you do. 

 Tables expand intelligently as your data grows. Add a row or column, and all formatting and formulas 
welcome the new data. Charts built from table columns also expand automatically. 

 Calculations performed on table constituents can use structured referencing—references that identify 
table cells by their column headings or row positions. 

 You can toggle a total row on or off, displaying sums, averages, and other aggregate calculations when 
needed.  

2 

3 

4 

5 

100 things you should know about Microsoft Office 2007

Page 25
Copyright ©2007 CNET Networks, Inc. All rights reserved. 

For more downloads and a free TechRepublic membership, please visit http://techrepublic.com.com/2001-6240-0.html



Let Formula AutoComplete assist with function building 
As soon as you type an equals sign followed by a letter, Excel displays the names of all available functions 
starting with that letter. Type another letter and the list narrows, and so on. Select an item in the list, and a tip 
appears describing the selected function. If you then press the parenthesis key, the tip changes to enumerate the 
function’s arguments. Macro programmers have long had this kind of help available for VBA functions; now 
regular spreadsheet jockeys can enjoy the same assist. 

Build prettier charts with fewer clicks 
The Ribbon is clearly a boon for chart-makers. When you select a data range (or a single cell within a range) and 
click the Insert tab, the major chart types appear as separate icons within a Ribbon command group. Click one of 
these major types (Column or Pie, for example), and a gallery of subtypes appears. Once you’ve planted your 
chart on the worksheet, three new Ribbon tabs arrive, giving you similarly direct access to nearly all the formatting 
features you’ll need. If you still want to dig deep into the formatting dialog box, you can do so, but most of the time 
it won’t be necessary. 

Microsoft disappointed a good many users by not adding new chart types in Excel 2007. But the old standbys 
have a new look and can dazzle with more razzle. On the Format tab, for example, you’ll find a gallery of Shape 
Effects that let you dress up your charts with glow, soft edges, bevels, and shadows. Best of all, perhaps, Excel 
now shares its charting engine with Word and PowerPoint. 

Find new ways to filter 
Probably the coolest change to Excel’s Filters (which used to be called AutoFilters) is that they recognize the type 
of data included in a column and offer options appropriate to the data type. If you filter a column of numbers, for 
example, the options include such things as Top 10 (it’s really top or bottom n; you can pluck out the highest three 
values, lowest 17, or whatever you need), Above Average, and Below Average. For text, you can do Begins With, 
Ends With, or Includes. And for dates, you get a huge assortment of intelligent filtering choices: Tomorrow, Today, 
Yesterday, Next Week, This Week, Last Week, Year to Date, and so on. 

The second coolest change is that you can filter a column on multiple discrete values. If your column includes 
North, South, East, and West, for example, you can use check boxes to restrict it to North and South, omitting 
East and West. Seems like a no-brainer, but there was no straightforward way to do this in Excel 2003. 

Make your PivotTables easier to read; build them with less frustration 
Microsoft has improved Excel’s PivotTable user interface with each new version, in an effort to make this 
extraordinarily valuable functionality less intimidating. In Excel 2007, you can populate a PivotTable by selecting 
field-heading check boxes as well as by dragging field headings onto a table layout (or into a task pane). These 
changes are marginally useful. More important, the 2007 interface includes some new context menus that make it 
easier to filter and sort (and you can use all the type-specific filtering options mentioned earlier). With the help of 
PivotTable styles (which appear on the Design tab when a PivotTable is selected), you can apply formatting that 
remains stable as the table pivots. And new layout options (Compact, Outline, and Tabular) afford greater 
legibility to complex tables. 

Reduce layout aggravations with Page Layout view 
Excel 2007 includes a new viewing option that shows page boundaries as you work (click Page Layout on the 
View tab to get there). This is essentially an enhanced version of the Page Break Preview mode that has been 
available in earlier versions. The principal difference is that Page Layout view is fully functional and interactive. 
That is, you can build your worksheet in it, noting how columns and rows will (or won’t) fit as you create them. On 
older hardware, you might notice a small performance degradation if you work this way. 
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By Debra Littlejohn Shinder, MVP, MCSE

Creating impressive slideshow presentations just got easier with Microsoft‘s latest version of PowerPoint. With a
new interface, new templates, and new artwork and formatting options, PowerPoint 2007 makes it a no-brainer for
you to give your presentations a polished, professional look and convey information in ways that grab and keep
your audience‘s attention.
Let‘s take a look at some of the key enhancements and new ways of doing things in the new PowerPoint.

#1: The Ribbon interface
The new user interface that‘s common to the main Office 2007 programs has gotten all the attention — and not all
of it positive. It takes some getting used to, but many users who‘ve given it a chance find it to be more intuitive
and quicker to use than the old menu system.
The Ribbon uses tabs to group commands and features in logical, task-oriented categories. In PowerPoint

2007, in addition to the familiar Home, Insert, Review, View, and Add-ins tabs, which are common to other Office
programs, you‘ll find tabs labeled Design, Animations, and Slideshow that are dedicated to those presentation ele-
ments, as shown in Figure A, Figure B, and Figure C.

Figure A: The Design tab allows you to choose page setup, themes and background.

Figure B: The Animations tab makes it easy to create animations and slide transitions.

Figure C: The Slide Show tab is used to set up and play the show and control monitor settings.
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#2: The Quick Style gallery
The new Quick Style gallery, with new themes, helps you to put to-
gether professional-looking presentations much more quickly be-
cause you don‘t have to select colors and style options individually.
Now you can be sure that your graphics elements, tables and charts
all match. When you apply a new style or theme, all of these ele-
ments change so that they go together and use the same color set.
You can choose from many built-in color schemes, as shown in
Figure D, or you can create your own custom themes.
When creating a new custom theme, you can set colors for various
components, as shown in Figure E.

The Quick Styles gallery changes to coor-
dinate with whatever theme you‘ve se-
lected, too. That means that elements
such as SmartArt graphics will be auto-
matically color coordinated with the rest of
the elements in the presentation.

#3: SmartArt
With PowerPoint 2003, you can insert WordArt or AutoShapes, but PowerPoint 2007 adds the concept of Smar-
tArt. SmartArt graphics are visual representations of information and ideas that are color coordinated and precon-
structed for common purposes, such as listing a number of components or subjects, showing hierarchical
relationships, illustrating the steps of a process or procedure, creating a matrix, and so forth.

Figure D: You can select from built-in
color themes or create your own.

Figure E: You can set colors for many different elements when you
create a custom theme.
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SmartArt graphics are easily added from the Insert tab, and as Figure F shows, you have dozens of graphics to
pick from..

When you‘ve inserted a SmartArt graphic, the Design tab opens and changes to provide options for editing the
graphic you‘ve selected. You can change colors or apply a 3D effect to the graphic by selecting from SmartArt
Styles in a drop-down list, as shown in Figure G.

Figure F: SmartArt graphics help you dress up a presentation quickly and easily.

Figure G: SmartArt graphics can be edited to change colors or apply 3D effects.
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#4: Better tables and charts
Tables and charts are important elements of many slide presentations, and PowerPoint 2007 makes it easier to
create and edit them. It‘s simpler to cut and paste information from Excel spreadsheets, and adding a table or
chart to a slide is a point-
and-click operation that‘s
done from the Insert tab.
There are also many more
built-in chart styles, as
shown in Figure H, and
they‘re easier to select and
work with. The new Table in-
sertion tool makes it simple
to highlight the columns and
rows that you want your
table to contain, as shown in
Figure I.

Figure H: Selecting and working with charts is easier in PowerPoint 2007.

Figure I: Columns and rows appear in your slide as you highlight boxes in the Table tool.
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#5: Live preview
One of the coolest and most useful features of PowerPoint 2007 is the live preview feature. You can see how vari-
ous color themes, fonts, and effects will look on the slide before selecting them.
For example, if you click the Colors down arrow in the Themes section of the Design tab, as you scroll through

different themes, they are instantly displayed on the slide.
The same thing happens as you move your cursor over different fonts in the drop-down box shown in Figure J.

The font instantly changes on the slide so you can see exactly what it will look like if you select that font.

#6: Presenter view
Another new feature in PowerPoint 2007 is the ability to run the presentation on one monitor while the audience
views it on a second monitor. In Presenter view, what you see on your monitor (for example, your laptop) and
what the audience sees on the second monitor (for example, the projector screen) are different.

Figure J: Fonts, colors and effects change instantly as you highlight them so you get a preview of exactly how
they will look on the slide.
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The audience sees only the slide
itself. But you see the current slide
along with your speaker notes and
previews of the next several slides
in sequence. You can click any of
those slides to go to it instantly, and
you can darken or lighten the audi-
ence screen without affecting your
own.
To turn on Presenter view, you

select the Slide Show tab, click Set
Up Slide Show from the Set Up
group, and select the Show Presen-
ter View check box in the Set Up
Show dialog box, as shown in
Figure K.
Figure L shows the Presenter view
that appears on your monitor on the
left and the slide that displays on
the audience‘s screen on the right.

#7: Smaller file size,
better file format
Elaborate slide presentations can
result in very large file sizes, espe-
cially if you use many graphics,
embed video, etc. This may
make it difficult to e-mail Power-
Point presentations to others because of mailbox limitations.
The new XML-based file format used by default in PowerPoint 2007 (.PPTX) reduces file sizes because the

files are compressed. This makes them significantly smaller, sometimes up to 75 percent. XML-based files are
also easier to recover if some elements in the file are corrupt or damaged.
If necessary for compatibility with older versions of PowerPoint, you can also save files in the PowerPoint 2003

(.PPT) format.

#8: Save as PDF or XPS
Now you can save PowerPoint presentations as PDF or XPS files. This makes it easier to share them with people
who don‘t have PowerPoint or who are using non-Microsoft operating systems, because these are standardized
formats that can be opened across platforms.
Saving in one of these fixed-layout formats also ensures that your presentation will stay exactly as you created

it, since they can’t easily be edited. It‘s also easy to print files saved in PDF or XPS, since “what you see is what
you get” in terms of the layout.
To save PowerPoint 2007 presentations in PDF or XPS, you first need to download the free add-in from

Microsoft. Once you install the add-in, just click Save As on the Office menu and select PDF from the Save As
Types drop-down list.

Figure K: You can select Presenter view in the Set Up Show dialog box.
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#9: Remove hidden information
Office 2007 programs, including PowerPoint, benefit from the new Document Inspector feature that makes it easy
for you to check your presentation to ensure that no hidden personal information or other metadata is contained in
the file before you share it with others. Especially if the presentation has been through a review process, there
could be comments, annotations, and so forth, still con-
tained in the file but not immediately visible. You might
not want others to be able to see your presentation notes
or off-slide content, either. To use the Document Inspec-
tor, select Prepare from the Office menu and then select
Inspect Document, as shown in Figure M.

#10: Secure your presentation
Sometimes, the information we include in our PowerPoint
presentations may be confidential. For example, you
might have a slideshow prepared for company executives
that contains trade secrets or financial information. There
are more ways than ever built into PowerPoint 2007 to
help you protect sensitive information in a slide show:

� You can add digital signatures to the PowerPoint file
to authenticate the identity of its creator and to verify
that the content hasn‘t been changed since it was
signed.

� You can encrypt the presentation.
� In the Windows Rights Management Services envi-

ronment, you can restrict permission so that users
with whom you share the presentation can’t copy,
print, or edit it.

All of these security mechanisms can be invoked from the Office | Prepare menu.

Figure L: Presenter view displays speaker notes and slide previews on your monitor and only the slide on the au-
dience‘s screen.

Figure M: You can inspect your presentation for hidden data
before distributing it.
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Version 1.0 
May 10, 2007 10 key enhancements in Outlook 2007 

By Jim Boyce 

The Ribbon 

If you have used other Office 2007 applications, you are no doubt familiar with the Ribbon -- and you either love it 
or hate it. Outlook 2007 uses the Ribbon, too, but not to the extent of other Office applications. 

The main Outlook window doesn’t use the Ribbon, but most of the forms do. For example, start a new e-mail 
message or appointment, and the resulting Outlook item form includes the Ribbon. As in other Office 2007 
applications, the main appeal of the Ribbon is that it exposes commonly used features. What’s more, the Ribbon 
exposes useful features that many users don’t know about or don’t bother with because they don’t want to spend 
the time hunting for the feature. 

I’ve been using Office 2007 since the earliest beta and didn’t discover until this week that you can minimize the 
Ribbon. Right-click on any group on the Ribbon and choose Minimize The Ribbon. Take the same action to 
restore it. 

Navigation Pane and To-Do Bar 

Outlook’s Navigation Pane provides a quick and easy way to navigate Outlook’s folders, views, calendars, date 
navigator, and other items. When Microsoft introduced the Navigation Pane in Outlook 2002, it was a big 
improvement over the Outlook Bar. There are a couple of nice additions to the Navigation Pane in 2007. 

You can now minimize the Navigation Pane to gain more screen real estate for messages, the calendar, and 
other views. To minimize the Navigation Pane, click the double left chevron in the upper-right corner of the 
Navigation Pane. This control changes to a double right chevron. Click that to restore the Navigation Pane. 

When the Navigation Pane is minimized, it acts like the Windows task bar in auto-hide mode. Just click on the 
Navigation Pane to open it. After you select an item from the Navigation Pane, it minimizes itself again. If you 
don’t want to use the Navigation Pane at all, choose View | Navigation Pane | Off to turn it off. Choose View | 
Navigation Pane | On to turn it back on. 

The To-Do Bar works much the same way as the Navigation Pane. You can configure the To-Do Bar to be 
minimized from the View menu. Then, when you need to use it, click on the double chevrons to expand or 
collapse it. You can also click on an area of the minimized To-Do Bar to temporarily expand it.” 

RSS feeds 

RSS, or Really Simple Syndication, is essentially an XML-based means to format news stories and other 
dynamically changing Web content so that RSS-aware software applications can access and retrieve this content 
automatically. Outlook 2007 supports RSS feeds, enabling you to receive information automatically from news 
and other Web sites that offer RSS content. RSS content arrives in Outlook much like e-mail messages and is 
stored in the RSS Feeds folder by default. 

The easiest way to add a feed is to click on the RSS Feeds folder and then click on one of the featured feeds in 
the resulting RSS directory. You can also right-click on the RSS Feeds folder and choose Add A New RSS Feed 
to open the New RSS Feed dialog box, in which you enter the URL for the feed. To modify an existing RSS feed, 
choose Tools | Account Settings and then click the RSS Feeds tab. Here, you can set the synchronization 
schedule, change the folder to which new items are delivered, remove a feed, and make other configuration 
changes for the feed. 
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Instant Search 

Instant Search is one of those features you’ll come to love in a hurry. Instant Search in Outlook 2007 integrates 
Outlook with Windows Desktop Search to enable you to almost instantly locate items in Outlook. For example, 
you can type in a word or phrase and find every e-mail in the current folder that contains that word or phrase. You 
can also expand the search to incorporate all mail folders, including those stored in your archive folders. 

Windows Desktop Search is included with Windows Vista. To use Windows Desktop Search on a Windows XP 
computer, you must download it from Microsoft. (For a look at how to use Desktop Search in Windows XP, see 
"Add Vista-like search capabilities to Windows XP.") 

Searching in Outlook 2007 is easy. Just click in the Search Inbox field located at the top of the current message 
window, type a word or phrase, and press ENTER. Outlook performs a search and displays a list of matching 
items in the window. Click Try Searching Again In All Mail Items to expand the search to all message folders. 
Click the X beside the search box to clear the search. 

Color categories 

Categories in Outlook help you organize and locate information. They've been improved in Outlook 2007 with the 
introduction of color. Previous versions of Outlook offered colored flags you could use to identify items, but they 
were text-based categories. Now they've been replaced by color categories in Outlook 2007. The category color 
appears in the message header and in the Categories field in the header list. The main advantage of using color 
categories is that they make it possible to quickly identify items based on their category. 

To assign a category, click the item and then click the Categorize button in the toolbar. You can select an existing 
color category from the resulting drop-down list, or click All Categories to create and assign a new category. The 
first time you use a color category, Outlook gives you the opportunity to rename it. Just type a new name in the 
resulting Rename Category dialog box and click Yes. If you don’t want to rename the category, click No. 

You can easily organize a view by category. Simply click the Categories header to group by color category. You 
can also use a predefined Categorized Mail search folder to locate all message that have category assignments. 

Quick click category 

Another handy color category feature in Outlook 2007 is the quick click category. This feature lets you assign a 
color category to a message with a single click. 

To set the quick click category, click Categorize in the toolbar and then click Set Quick Click to open the Set 
Quick Click dialog box. Select the desired category and click OK. To apply the Quick Click Category to an item, 
just click in the Categories field for the item. 

Flag recipient for follow-up 

You're probably familiar with Outlook’s follow-up feature that lets you set a follow-up flag for items. For example, 
you might want to flag a message to follow up the next day with a phone call. A handy feature in Outlook 2007 is 
the capability to flag a message for a recipient to follow up. 

For example, assume you want the recipient to take action by the end of the week on a message you send. When 
you are ready to send the message, click the Follow Up button in the Options group on the Ribbon, then choose 
Flag For Recipients. In the resulting Custom dialog box, choose the desired follow-up action from the Flag To 
drop-down list. Specify a reminder day and time and click OK. Then, send the message. When the reminder time 
arrives, the recipient will receive an Outlook reminder regarding the item. 
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Calendar overlay 

If you manage multiple calendars, you'll really appreciate Outlook 2007’s new calendar overlay feature, which lets 
you combine multiple calendars into a single view. For example, you might track your personal appointments on a 
separate calendar from your business appointments. Or maybe you want to merge a sports calendar with your 
work or personal calendar, or look at two or three staff members’ calendars in one view. Calendar overlay 
provides a great means for identifying conflicts or getting a complete picture of your schedule. 

Merging calendars is easy. Open the Calendar folder. Then, in the Navigation Pane, place a check beside the 
calendars you want to view. Outlook displays the calendars side by side. In the name tab at the top of one of the 
secondary calendars, click the View In Overlay Mode button to overlay the calendar with the primary one. Repeat 
for any additional calendars you want to overlay. To view the calendars separately, click the View In Side-by-Side 
Mode button in the calendar’s name tab. 

Scheduling Assistant 

If you're using Outlook 2007 with Exchange Server 2007, the Scheduling Assistant can help you choose a 
meeting time that works best for all of the specified participants. Unlike the AutoPick Next feature, which just 
automatically selects the next time slot that fits everyone’s schedules, the Scheduling Assistant analyses 
attendees’ schedules and suggests several times for the meeting. The Scheduling Assistant identifies for each 
suggested time how many of the attendees and resources (such as meeting rooms) are free. You can click on a 
suggested time slot and then choose a meeting room from the drop-down list of available rooms Outlook offers. 

Out-of-office scheduling 

The Out Of Office Assistant, which enables you to generate out-of-office messages when using Outlook with 
Exchange Server, has also been improved in Outlook 2007. When used with Exchange Server 2003 or earlier, 
the out-of-office features are essentially the same in Outlook 2007 as in Outlook 2003. The only difference is the 
dialog box you use to specify the out-of-office message and rules. To set out-of-office options, regardless of which 
version of Exchange Server you are using, choose Tools | Out Of Office Assistant. 

When used with Exchange Server 2007, you have additional out-of-office features. First, you can schedule your 
out-of-office period ahead of time. To do so, open the Out Of Office Assistant, choose Send Out Of Office Auto-
Replies, select Only Send During This Time Range, and enter the beginning and end dates and times for the out-
of-office period. When the start date and time arrives, Exchange begins sending out-of-office replies. 

The other Exchange Server 2007-specific out-of-office feature is the capability to send out-of-office replies to 
people inside your organization that are different from the replies that go to people outside your organization. The 
Out Of Office Assistant dialog box offers two tabs, one for internal replies and one for external replies. Just click 
the appropriate tab and enter the out-of-office reply you want to use for that group. 
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By Jeff Conrad

The Microsoft Access development team added more features into Access 2007 than probably any other previous
version. You’ll definitely want to see what all the buzz is about around this latest incarnation of the popular desk-
top database application. Truth be told, I found it hard to pick out just 10 new features to highlight for this article.

#1: A redesigned user interface offers new tools
Virtually every aspect of the user interface in Access 2007 has been changed. If you’ve worked with previous ver-
sions of Access, you’ll be relearning how to work within Access. This latest version includes a new Ribbon, Office
menu, Quick Access toolbar, and Navigation Pane (Figure A). The latter is the replacement for the Database Win-
dow from previous versions. You need to plan for an initial decrease in your productivity as you familiarize yourself
with all these new UI elements.

#2:Layout view makes it easier to design your forms and reports
Access 2007 includes a new Layout view to help you design your forms and reports (Figure B). With this view,
you can easily customize your forms and reports while viewing live data in the controls. You can also quickly
move, resize, and align your form and report controls without having to switch to Design view. You can save valu-
able development time using the new Layout view to help position controls.

Version 1.0
June 4, 200710 key enhancements in Access 2007

Figure A

Page 37
Copyright ©2007 CNET Networks, Inc. All rights reserved. 

For more downloads and a free TechRepublic membership, please visit http://techrepublic.com.com/2001-6240-0.html



#3: Report view lets you filter your reports
Access 2007 includes a new view for reports called Report view. You get a static snapshot of your data with the
traditional Print Preview, but with the new Report view, you can dynamically filter the data and drill down to print
only the information you need. Just right-click inside a control and select various filtering options from a contextual
shortcut menu (Figure C).

#4: Date Picker simplifies entering dates
For a long time, developers have been asking for an improved method of inputting dates into Access. This latest
version includes a built-in Date Picker control you can use for data types designated as Date/Time. Access dis-
plays a small button next to these fields in datasheets and forms. When you click this button, Access displays a
small pop-up calendar control, making it very easy to select a date (Figure D). On forms, you can choose a prop-
erty setting (Show Date Picker) to not display this Date Picker.

Figure B
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Figure C

Figure D
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#5: Enhanced Quick Create commands help you build tables, forms, and reports
Access 2007 includes enhanced Quick Create commands that help you build new forms and reports with the click
of a button. These enhanced commands create new data entry forms and reports complete with controls and
graphics. The commands will help you get a jump-start on adding new objects to your database. Look for these
commands on the Create tab of the Ribbon (Figure E).

#6: Alternating row color makes your data stand out
In previous versions of Access, you had to write code to alternate the background color of records on forms and
reports. Access 2007 offers a built-in feature for this, which can even be used for datasheets. The new alternating
row color effect, also referred to as the “greenbar” effect, makes it easier to read your data when you have a lot of
repeating rows positioned close together. You can find the Alternating Row Color button in the Design group on
the Ribbon (Figure F).

Figure E

Figure F
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#7: New Attachment data type reduces database bloat
A common question seen in Access newsgroups and support forums is how to add attachments to records without
seeing significant database bloat. Access 2007 introduces a new data type called Attachment that allows you
save one or more attachments (pictures, spreadsheets, documents, and so on) with a record (Figure G). With the
added benefit of better compression in this version, you can easily add pictures to your records where appropri-
ate. The Access development team added this new data type to align better with Microsoft Windows SharePoint
Services.

#8: Multi-value field lookups ease the pain of creating many-to-many
relationships
Lookup fields display one value in a field but store a different value. Access 2007 adds onto the existing concept
of lookup data types by allowing you to create multi-value field lookups to handle complex data. With multi-value
field lookups, you can store multiple values in a single lookup field. For example, in a field of Trained Positions,
you could store all the trained job code positions for each employee. Whenever you use a multi-value field lookup,
Access 2007 displays a special control that looks like a hybrid combo box-list box control (Figure H). When you
click the down arrow on the control, you can individually select each of the related records. Hidden from the user
interface, Access 2007 creates the appropriate many-to-many relationships, including the third junction table, to
handle the complex relationship.

Figure G
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#9: New feature lets you collect and import data via e-mail
An exciting new feature in Access 2007 is the ability to collect data through e-mail and import it into your data-
base. You can use forms created with HTML or rich forms created with Microsoft Office InfoPath 2007. If you use
HTML, your recipients need only have an e-mail client program that accepts HTML. If you use the InfoPath forms,
you and your recipients must all be using Microsoft Office Outlook 2007 and InfoPath 2007. Why spend extra time
updating membership records when your members can update their own records?! A wizard walks you through
the steps necessary to create your data collection forms (Figure I).

Figure H

Figure I
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# 10: Finally, rich text is built into Access
For all previous versions of Access, developers had to rely on third-party controls to have rich text capabilities —
but no longer! Access 2007 includes the ability to have rich text in text and memo fields (Figure J). This formatting
is stored as HTML. Go ahead and add in some fancy colors, bold face, italics, underlines, bullets, and more.

Jeff Conrad was awarded Microsoft’s Most Valuable Professional award from 2005 to 2007 for his continual in-
volvement with the online Access community. He is co-author of Microsoft Office Access 2007 Inside Out and is a
contributing author of Microsoft Office 2007 Inside Out. Because Jeff knows Access “Inside Out,” he recently
joined Microsoft as a Software Design Engineer in Test working with Access and Excel technologies. To learn
more, visit his Web site at http://www.AccessJunkie.com.

Figure J
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